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EFiling – First Circuit Court of Appeal 

Frequently Asked Questions – Posted June 11, 2014 

Implementation Scheduled for Monday, June 16, 2014 at 8:30 a.m. 

 

What is EFiling? 

 

Via EClerk’s Counter on http://www.la-fcca.org, EFiling is the electronic 

transmission of a document to the Court that would otherwise be brought to the 

Court by courier or through the U.S. postal service or other shipping service. 

 

Is EFiling mandatory? 

 

No. 

 

What documents can be EFiled? 

 

All documents, including applications, briefs, motions, etc., that can be filed by 

parties in a case may be uploaded for filing with the Court using the EFiling 

service. 

 

Can EFiling be prohibited? 

 

Yes. Although EFiling is allowed in all cases generally, the court may order, on its 

own motion or on motion of a party, that this filing method is prohibited in a 

specific case, for a certain document or documents, or by a specific attorney or 

party. 

 

Is a registration process required to use EFiling? 

 

The EFiling service is part of EClerk’s Counter. A person registered for EClerk’s 

Counter is automatically enabled to use this service to upload documents for 

EFiling by logging in with his or her username and password. If a person is not 

registered for EClerk’s Counter, he or she will need to create a username and 

password on implementation day, Monday, June 16, 2014. 

 

How much does it cost to EFile? 

 

Pursuant to Local Rule 1-11(b), there is a five dollar surcharge covering copying 

costs assessed for each uploaded document to be EFiled, regardless of whether a 

http://www.la-fcca.org/
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filing fee is required for that document. Exempt and pauper filers are required to 

pay this copying surcharge for each uploaded document. 

 

Who can upload a document for EFiling? 

 

Any registered user may upload a document for EFiling provided the applicable 

$5.00 per document EFiling surcharge plus the regular filing fee for the particular 

document, if applicable, is paid via credit card.  However, for the uploaded 

document to be filed and not rejected, the document must bear an appropriate 

electronic signature of the intended filer and, when an affidavit is required of the 

filer by the Uniform Rules, must contain a declaration in lieu of the affidavit. 

 

Can I EFile and pay later? 

 

No. The system will not allow you to submit your document without payment. If a 

registered user selects “8. ALL OTHER CIVIL AND CRIMINAL DOCUMENTS 

– NO FILING FEE” in error and proceeds to pay only the $5.00 per document 

surcharge, the Clerk’s Office will contact the registered user to request the user to 

pay the delinquent amount online using a credit card (note: payment of a 

delinquent amount is an option only if the document to be uploaded is compliant 

with the rules). 

 

Who will be notified that the Court has received my EFiling? 

 

The registered user uploading the document to EFile will receive an 

acknowledgment email stating the document was successfully uploaded to the 

Court. The filer may presume the uploaded document will be filed as of the date 

and time uploaded unless the filer is otherwise notified via phone call by the 

Clerk’s Office (a document may be rejected by the Clerk’s Office for non-

compliance with court rules or insufficient payment; to the extent allowed by the 

Court, the Clerk’s Office will work with the filer to correct an insufficient payment 

and/or cause an appropriate document to be filed). 

 

When is EFiling available? 

 

A document may be uploaded for EFiling at any time, including before or after 

weekday business hours, weekends, and holidays. However, the Clerk’s Office 

only processes and checks for compliance on uploaded documents during business 

hours.  
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Are there special restrictions on a document to be uploaded for EFiling? 

 

Yes: 

1) The document must be saved in PDF format (although appendices and/or 

exhibit materials may be scanned for insertion provided the scanning is legible); 

2) The document size cannot exceed 175 megabytes; and 

3) Unless Local Rule 8 provides otherwise, the content and format, except for 

binding, must comply with the Uniform Rules. 

 

What is an appropriate electronic signature? 

 

Local Rule 8 defines “electronic signature" as an electronic sound, symbol, or 

process attached to or logically associated with a document and executed or 

adopted by a person with the intent to sign the document. 

 

Signers are highly encouraged to visit the Adobe website to learn more about 

options for signing a PDF document electronically. For your convenience, 

Attachment A is the Adobe Acrobat XI “Quick Start Guide” about signing a PDF 

file which is also available on the adobe website address below: 

http://www.adobe.com/products/acrobat/electronic-signatures-e-signatures.html 

 

What if the system does not accept my document? 

 

If the system does not accept your document, you should retry. If this does not 

work, or if retrying causes you to miss your filing deadline, you may seek relief 

from the Court in the form of a motion and proposed order requesting such relief.  

The Court will make the determination in regard to timeliness in this instance 

because the Clerk’s Office does not take any technical difficulty into account in its 

determination of timeliness of a document to be EFiled. 

 

What if the system is down on my filing deadline? 

 

Local Rule 8 allows a party to seek appropriate relief from the Court in the form of 

a motion and proposed order for technical failures that result in missing a filing 

deadline.  However, if a party knows that the system is not functional, every effort 

should be made to mail or deliver the filing timely. 

  

http://www.adobe.com/products/acrobat/electronic-signatures-e-signatures.html
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How do I EFile a document? 

 

A step-by-step demo of how the EFiling process works will be posted to the 

Court’s website on implementation day, Monday, June 16, 2014. 

 

What if I select a wrong document type associated with a filing fee? 

 

If the uploaded document is compliant with the rules, but the filing fee selected and 

paid is below the amount required for filing of that particular document type, the 

Clerk’s Office will contact the registered user to request the user to pay the 

delinquent amount online using a credit card. The uploaded document will be filed 

as of the date and time the delinquent amount is actually paid. 

 

If the uploaded document is compliant with the rules, but the filing fee selected and 

paid is higher than or equal to the amount required for filing of that particular 

document, the document will be filed.  Any amount in excess of the required filing 

fee will be refunded to the payer. 

 

To ensure that you do not select the incorrect filing fee, double check that you have 

selected the correct fee when reviewing your cart before final submission of your 

document for EFiling. 

 

Exempt and pauper filers should select “8. ALL OTHER CIVIL AND 

CRIMINAL DOCUMENTS – NO FILING FEE” for any document to be uploaded 

for EFiling. 

 

How do I turn a word processing document into PDF format? 

 

Microsoft Word or WordPerfect documents can be easily converted to PDF format. 

Guidelines for the most recent versions are attached as Appendix B. 

 

You can also purchase the full version of Adobe Acrobat, which provides the 

ability to convert many document types to PDF and many other useful features, 

including “signing” which meets the definition of “electronic signature”.  You will 

need to familiarize yourself with the Adobe product and the “how to” convert your 

documents using this software. 
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Other than directing you to these guidelines for Word and WordPerfect and the 

helpful tip about purchasing the full version of Adobe Acrobat, the Clerk’s Office 

will not be able to assist you with any further technical advice to accomplish a PDF 

conversion. 

 

How do I insert a scanned appendix and/or an exhibit into the PDF document 

I have created?  

 

Local Rule 8 provides that appendices and/or exhibit materials may be scanned for 

insertion into your PDF document to be uploaded for EFiling. Prior to placing your 

electronic signature on the document to be uploaded for EFiling, you should open 

the PDF document you have created from your word processing software and 

choose the insert file option.  Find you scanned document where you have saved it 

on your computer and choose where/how to insert it when the Adobe insert 

dialogue box appears.  Repeat this process to incorporate all the appendices and/or 

exhibit materials. 

 

How do I “Bates number” a PDF document? 

 

The Uniform Rules require that certain documents including appendices and 

exhibits (such as writ applications) be consecutively numbered.  There are a 

number of articles and instruction guides available on the internet on how to “Bates 

number” this type of submission which can be found by doing a simple google 

search: “adobe Bates numbering” to yield helpful results. 

 

What about electronic service?  

 

EClerk’s Counter does not offer electronic service; therefore, EFiling with the 

Court has no impact on service requirements among parties as provided by law, 

electronic or otherwise. 

 

Who should I contact for more information or assistance with EFiling?  

 

Contact the Clerk of Court’s Office at (225) 382-3000.  



Adobe Acrobat XI Quick start guide

Sign a PDF file with Adobe® Acrobat® XI
Place your signature anywhere on a PDF file and send your document. Choose from a 
typewritten or hand-drawn appearance, or import a signature image.

1. Open the PDF file you want to sign.

2. At the top right in Acrobat, click the Sign pane. Open the I Need to Sign panel.

3. Click Place Signature. 

4. Select one of the following options for signing in the drop-down box. To use a certificate, see the “Use 
an existing Certificate” section below.

a. Type My Signature

•	 In	the	Enter	Your	Name	box,	type	your	name.

•	 To	toggle	between	appearance	options,	click	Change	Signature	Style.	Click	Accept.

•	 Scroll	to	the	desired	location,	and	click	to	place	the	signature.

b. Draw My Signature

•	 Use	your	mouse	or	stylus	to	draw	your	signature	in	the	box.	If	needed,	click	Clear	Signature	to	
start over. Click Accept.

•	 Scroll	to	the	desired	location,	and	click	to	place	the	signature.

c. Use an Image

•	 Physically	sign	a	piece	of	paper	and	scan	the	paper	to	a	PDF	file.	See	Scan paper to PDF and 
apply OCR with Acrobat XI.

•	 Browse	to	the	file	that	contains	your	handwritten	signature.	Click	Accept.

•	 Scroll	to	the	desired	location,	and	click	to	place	the	signature.

5. To sign your file more than once, click Place Signature again. Scroll to the desired location, and click 
to place the signature.

6. To permanently merge the signature into the PDF, save the file. Click Confirm to finalize the changes. 
Type a name for your file. Click Save.

7.	 You	are	presented	with	an	option	to	send	the	signed	document	to	others	with	Adobe	EchoSign.	To	
continue, click Upload and see step 6 of Get others to sign a PDF file with Acrobat XI. If do not want 
to	use	the	Adobe	EchoSign	service,	click	Not	Now.

Tip: Acrobat sets the first signature method chosen as the default method of signing. To change methods, 
click the down arrow next to Place Signature, and select Change Saved Signature to return to the full list of 
options. The method you choose becomes the default.

http://www.adobe.com/content/dam/Adobe/en/products/acrobat/pdfs/adobe-acrobat-xi-scan-paper-to-pdf-and-apply-ocr-tutorial-ue.pdf
http://www.adobe.com/content/dam/Adobe/en/products/acrobat/pdfs/adobe-acrobat-xi-scan-paper-to-pdf-and-apply-ocr-tutorial-ue.pdf
http://www.adobe.com/content/dam/Adobe/en/products/acrobat/pdfs/adobe-acrobat-xi-others-esign-pdf-file-tutorial-ue.pdf
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Adobe Systems Incorporated 
345 Park Avenue 
San Jose, CA 95110-2704  
USA 
www.adobe.com

Use an existing Certificate
1. Open the PDF file you want to sign.

2. At the top right in Acrobat, click the Sign pane. Open the I Need to Sign panel.

3. Click Place Signature. 

4. With your mouse, draw a box where you want the signature to appear. When you finish 
drawing, the Sign Document dialog box opens.

5. Select your digital ID and type the password. Click Sign.

6. Type a name for your file, and click Save. The file shows a blue bar at the top of the screen 
indicating that the PDF file is signed.

To learn more about certificate signatures, visit http://helpx.adobe.com/acrobat/kb/certificate-
signatures.html.

Tip:  Acrobat sets the first signature method chosen as the default method of signing.  To clear out 
Digital IDs in Acrobat, select Edit > Preferences > select Signatures on the left side of the screen > click 
More after Identities & Trusted Certificates > select the relevant Digital ID > click Remove ID > confirm 
that you want to remove the Digital ID> enter the password > click OK

Tip: To learn more about other signature options, see Get others to sign a PDF file with Acrobat XI.

For more information
www.adobe.com/products/
acrobat

Popular Searches: PDF e-sign, Sign PDF review, PDF files e-signatures, PDF version control, Password protect PDF files 

Adobe, the Adobe logo, and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.  
All other trademarks are the property of their respective owners.

© 2012 Adobe Systems Incorporated. All rights reserved. Printed in the USA.

91073509  7/12

http://helpx.adobe.com/acrobat/kb/certificate-signatures.html
http://helpx.adobe.com/acrobat/kb/certificate-signatures.html
http://www.adobe.com/content/dam/Adobe/en/products/acrobat/pdfs/adobe-acrobat-xi-others-esign-pdf-file-tutorial-ue.pdf
http://www.adobe.com/products/acrobat
http://www.adobe.com/products/acrobat
http://www.adobe.com/products/acrobat/esign-with-echosign.html
http://www.adobe.com/products/acrobat/sign-pdf-review.html
http://www.adobe.com/products/acrobat/electronic-signatures-e-signatures.html
http://www.adobe.com/products/acrobat/pdf-version-control-sharepoint-integration.html
http://www.adobe.com/products/acrobat/pdf-file-password-permissions.html


Guidelines for Converting Microsoft Word Documents to PDF 
 
For Microsoft Word 2007, a free add-in is available to download that allows a 
Word document to be saved in PDF format; the site to access the download is: 
http://www.microsoft.com/en-us/download/details.aspx?id=9943 
 
Once the add-in is downloaded and installed: 
1) Click on the Office Button; and 2) Choose Save As and Adobe PDF 

 
3) In the dialogue box that opens, verify the location where you wish to save the 
document 
4) Choose an appropriate file name 
5) Click “Save” 
 
For Microsoft Word 2010: 
 
1) From the File menu, select “Save as Adobe PDF” 

 
2) In the dialogue box that opens, verify the location where you wish to save the 
document 
3) Choose an appropriate file name 
4) Click “Save”  

http://www.microsoft.com/en-us/download/details.aspx?id=9943
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For Microsoft Word 2013: 
 
1) Click on File on the menu bar 

 
2) Select “Save As: and choose the place where you would like to save your 
document from the options presented. 

 
3) Change “Save as type” in the dialogue box to PDF, verify the location where 
you want to save the document, choose an appropriate file name and click the 
SAVE button. 

 



Guidelines for Converting Corel WordPerfect Documents to PDF 
 
Working with PDF Files in WordPerfect X4 
Written by: Michele McDonough, edited by Bill Fulks, updated: 6/3/2010 
http://www.brighthub.com/computing/windows-platform/articles/23899.aspx 
 
1) From the File menu, select the Publish to PDF option. 

 
 
2) Navigate to the directory where you want to “Save in: and enter a “File name” 
for the document. Also, from the PDF Style drop down list, select “Publishing 
online and printing”. 

 
3) Click the SAVE button; the following progress bar box appears; once the PDF is 
created, the progress bar box will close 

 

http://www.brighthub.com/computing/windows-platform/articles/23899.aspx



